Extron

Extron Certified DSP Bundle for Microsoft® Teams®
Rooms - Medium Room ¢ Setup Guide

IMPORTANT NOTE:

Go to www.extron.com for the complete user guide, installation instructions, and specifications.

Microsoft Teams and Extron have come together to provide Teams Rooms solutions. The Extron certified DSP bundle for Microsoft
Teams Rooms provides flexible and easy-to-use realtime collaboration.

Requirements
Extron Equipment List
Product Description Quantity
DMP 64 Plus C V AT 6x4 Digital Matrix Processor w/ AEC, VolP, and Dante® 1
XPA U 1002-70V Two-Channel Amplifier, 100 watts at 70 volts 1
IPCP Pro 250 xi Control Processor with LinkLicense Ul upgrade 1
SF 3CT LP 3" Full-Range Ceiling Speakers, 70/100V, pair 1
RSU 129 1U 9.5" Deep Universal Rack Shelf, Gray 1
SPK16P 16 AWG Plenum Speaker Cable - 75' (22.8 m) 1
USB CFG cable USB A Male to USB Mini B Male 6’ (1.8 m) 1
MLC PW Audio cable Audio patch cable for audio DSP output to amplifier input - 6' (1.8 m) 1
Network cable UTP RJ-45 Cat-5e Plenum network cable - 35' (10.7 m) 1
Network cable Cat-6 Non-Plenum network cable - 6' (1.8 m) 2
Sennheiser® Equipment List
Product | Description | Quantity
TeamConnect Ceiling Medium | Beamforming Ceiling Microphone array | 1
Additional Required Equipment

Product | Description | Quantity
Teams Rooms computer Teams Rooms computer with camera and control interface 1
Network switch 10-port PoE network switch 1
Windows® computer or laptop Computer MUST contain the following: 1

e Extron DSP Configurator

e Extron Global Configurator Plus and Professional

e Extron Toolbelt

e Dante Controller

e Sennheiser Control Cockpit

e  Extron system configuration *.zip files
NOTE: The Windows computer or laptop is required for adjustments and can be disconnected after system configuration.
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System Diagram

The following system diagram shows how to set up the DMP 64 Plus C V AT for use with Microsoft Teams in a conference room.
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Figure 1. System Diagram Example

NOTE: The supplied network switch is manageable. However, the default configuration is sufficient for this solution to
function.
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Installation Details

Audio Cables

See figure 2 for the connections needed between the DMP Plus and the XPA U amplifier. Use the supplied balanced audio cable to
connect each product.

Tip + Tip .
Ring ! Ring '
Sleeve < Sleeve (s) < ——
Tip +
Balanced Output Ring '

% (5 mm) MAX.
DMP Plus 3-pole XPA U 5-pole Do not tin
Audio Output wiring Balanced Dual Mono Input the wires!

Figure 2. Captive Screw Audio Cable Wiring

Amplifier and Speaker Installation

During installation of the amplifier and speakers, please ensure that their settings are compatible. The bundled XPA U 1002 is a
70 V power amplifier. Set each SF 3 CT LP rotary tap selector switch to 70 V, 16W.

For detailed setup instructions please see the XPA Ultra Series Setup Guide and SF 3CT LP Setup Guide at www.extron.com.

Adjust the Tap Selector

Figure 3. Adjusting the Speaker

Configuration Overview

1. Unbox and connect the provided hardware using the diagram in figure 1 on page 2.

NOTE: Do not connect the USB cable between the Microsoft Teams Rooms computer and Extron DMP Plus until after
the Extron DMP Plus is completely configured.

2. Install the following software utilities on the computer:
e  Extron DSP Configurator Software
e  Extron Global Configurator Plus and Professional
e  Extron Toolbelt
e Dante Controller Software
e Sennheiser Control Cockpit Software
3. Download the following from the Extron website (www.extron.com):

e  Extron Medium Conference Room System File .zip folder
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Sennheiser TeamConnect Ceiling Medium Setup

Sennheiser TeamConnect Ceiling Medium

A single network cable connection from the Sennheiser TeamConnect Ceiling Medium (TCC M) to the network switch supports PoE
into the microphone, Dante audio, and LED feedback for call and mute status. The browser-based Control Cockpit interface detects
and identifies the TCC M when the network cable is attached to the PoE IN/Ctrl port and the microphone is powered on.

Device List 0/2 devices

TCCM-A

TCCM-B

Figure 4. Control Cockpit Interface
From this interface, carry out the following actions:
e  Setting Network Settings

e Beam-steering and Exclusion Zone Adjustments (Optional)

Setting Network Settings

Select the Network tab to configure and document the IP address and host name of the device. This is required later.

Properties
o Audio @ Zones ice &+ Network

TeamConnect Ceiling Medium 1 selece
Ethernet Settings MAC Address (D

IP mode Fixed IP Ethernet 00:1B:66:00:00:00

mDNS On Il

P 192.168.254.250
Subnet 255.255.255.0
Gateway 0.0.0.0

Figure 5. Control Cockpit Network Interface
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Third-party Access

1.

2,

Select the Access tab to enable third-party access and configure a third-party Password.

Properties

TeamConnect Ceiling Medium 1 selectec

3rd Party Access Device Access

Access Activated Password
Username

Password

Figure 6. Configuring Third-party Access

Document the third-party password for the device. This is required later.

Beam-steering and Exclusion Zone Adjustments (Optional)

If additional settings are required to reduce background noise of items such as HVAC, projector fans, or credenzas, the TCC M has
a Priority Zone and up to five Exclusion Zones, which can be leveraged to remove these from the microphone pickup.

To configure a zone:

1.

2
3.
4

Select the desired unit from the Device List (see figure 4 on page 4). A Properties dialog box opens.
Select the Zones tab. The 3D Overall View shows the real-time focus of the TCC M automatic beam-steering (see figure 7).
Enable a Priority Zone or Exclusion Zone.

Edit the vertical and horizontal angles of the selected exclusion zones (see figure 8 on page 6) to remove the observed
noise.

NOTE: Refertothe TeamConnect Ceiling Medium instruction manual for more information.

Properties
o Audio @ Zones
TeamConnect Ceiling Medium 1 selecte
Zones @ 3D Overall View @

Rotate the 3D model by dragging it
to the left or right with the mouse
cursor.

Priority Zone

Exclusion Zones

On

Beam
247 [ 14°

Figure 7. Control Cockpit Zones Tab
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Properties

o Audio @ Zones

TeamConnect Ceiling Medium 1 selecte

Zones @

Exclusion Zone 1

3D Overall View @

Rotate the 3D model by dragging it

to the left or right with the mouse
cursor.

—

9
Vertical Zone: 0° / 10°

Beam

Horizontal Zone: 0° / 0° 247° [ 14°

Apply Revert

Figure 8. Control Cockpit Exclusion Zones Adjustment

Dante Controller Setup

Dante Controller from Audinate® is required to route transmitters and receivers, and can be used to configure Dante settings and
monitor performance.

Creating Subscriptions Between the Sennheiser TCC M and the Extron DMP 64 Plus C V AT

Ensure the laptop, DMP 64 Plus C V AT (Dante), and TCC M (Dante) are connected to the same network.

2. From the Windows Start menu select: A11 Programs > Audinate > Dante Controller. The Dante Controller - Network
View screen opens. The Dante Controller auto-discovers Dante devices on the network and advertises itself to allow other
Dante-enabled devices to communicate with it. Transmitters connect to receivers using the subscription matrix.

& Dante Controller - Network View

File Devices View Help
U9 @k a @ H O

Routing Device Info Clock Status  Network Status  Events

@aDante

Filter Transmitters

Filter Receivers

DMPG4P-123456 +
TCCM-123456 +

+| [ | Transmitters (2)

+| |=| Receivers (2)
+| DMP64P-123456 +
+/TCCM-123456 H

Figure 9. Routing Tab of the Dante Controller Network View

NOTE: The DMP 64 Plus C V AT and TCC M Dante connections are set to DHCP by default. If they cannot be
discovered, ensure the correct interface is selected on the PC by selecting Interfaces from the File menu.

3. Open the Device View of the DMP 64 Plus C V AT by double-clicking the device name in the Routing tab.
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4. Inthe Receive tab, click on the first channel name and rename it TCCM-A.

| & Dante Controller - Device View (DMP64P-123456)

- O X
| File Devices View Help
2 B ® < H @ DMP64P-123456 &

Receive Transmit Status Latency Device Config MNetwork Config AES&7 Config

Receive Channels Available Channels

Channel Connected To Signal
() TCCM-A +-DMP64P-123456
| ) Exp_in02 + TCCM-123456
_In
) Exp_In-03

Figure 10. Receive Tab of the DMP Plus Device View
5. Selectthe Transmit tab.

6. Click on the first channel name and rename it TCCM Ref.

& Dante Controller - Device View (DMP6&4P-123456)

File Devices View Help

2 0 © < H a DMP64P-123456 )
Receive Transmit Status Latency Device Config Network Config AES67 Config
Transmit Channels Multicast Transmit Flows
Channel
) TCCM Ref |
{3 Exp_Out-02

Signal

Figure 11. Transmit Tab of DMP Plus Device View

7. Select the Device Config tab and rename the DMP 64 P1lus C V AT as desired.

8. Click Apply.

& Dante Contreller - Device View (DMP64P-123456)
File Devices View Help
2 W © < H o DMP64P-123456 @

Receive Transmit Status Latency Device Config Network Config AES67 Config

Device

DMPEPlusCVAT] Apply

Press ESC to cancel editing. Names must not begin or end with - (dash).

Figure 12. Device Config Tab of DMP Plus Device View

9. From the Device View drop-down menu, choose the TCCM (see figure 13, @)).

10. In the Device Config tab, rename the TCC M microphone to TCCM-A.

& Dante Contreller - Device View (TCCM-123456)

File Devices View Help

2 W © < H o TCCM-123456 o

Receive Transmit Status Latency Device Config Network Config AES67 Config

Device

TCCM-A| Apply

Press ESC to cancel editing. Names must not begin or end with - (dash).

Figure 13. Device Config Tab of TCC M Device View

11. Close the Device View window and return to the Network View window.
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12. To show the receivers of the DMP Plus device, click the + box next to the desired device in the Receivers list (see figure 14,
@). The + sign changes to a - sign when the list expands.

13. Click the intersections of the desired subscriptions between transmitter and receiver channels (@).

& Dante Controller - Network View

File Devices View Help
U9 @& &S H 0@

Routing Device Info Clock Status  Network Status  Events

@Dante
.Fllter Transmitters

Filter Receivers

TCCM-A -

DMP&4PlusCVAT [+
FarEndOut O
Localout D

+|[ | Transmitters (2)

+/ |-/ Receivers (2)
~ DMP64PlusCVAT o H = 9
QTCCM-A

& v
Q) Exp_In-02

Figure 14. DMP Plus Subscription to TCC M

14. To show the transmitters of the TCC M, click the + box next to the desired device in the Dante Receivers panel (see figure 15,
(1)}

15. Click the intersections of the desired subscriptions between transmitter and receiver channels (@).

& Dante Controller - Network View

File Devices View Help
U @k a & H o0

Routing Device Info Clock Status  Network Status  Events

T +

@Dante g ;

auan $0000000N0NNNNONN T

%ﬁclmv—mmhma\o.—-r!mvmm =

- B bbbl hobobolog =
Filter Transmitters TR e R e e e e R e P B e
& 2 56,0009690009 0,600 09
| gfccgococcogcocccooc
L g [ru e R AP P R P P Y Y e

Filter Receivers

+ |1 Transmitters (2)

+ [~ Receivers (1) 9
— TCCHM-A = [+]
LY (¥

() FarEndRef

Figure 15. TCC M Subscription to DMP Plus

NOTES:

e The FarEndOut transmitter channel of the TCC M device should be routed to the first receiver channel of the
DMP 64 Plus C V AT. A check mark at the intersection indicates the subscription is made. A check mark also appears
next to the receive channel.

e The TCCM Ref transmitter channel of the DMP 64 Plus C V AT should be routed to the FarEndRef receiver channel
of the TCC M.
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Extron DMP 64 Plus C V AT Setup

To configure the Extron DMP 64 Plus C V AT, perform these steps:

1.
2,

Use a browser to connect to the embedded web page of the DMP and use the controls to set IP address.

Set the computer or laptop IP address within the range of the product IP address. The default settings are (LAN for
non-V models, LAN 1 for V models):

e |PAddress: 192.168.254.254
e  Subnet: 255.255.255.0
e (Gateway: 0.0.0.0

From a web browser, enter the device IP address into the address field.

NOTE: If the local system administrators have not changed the IP address, and the device has not been assigned an IP

address via DHCP, the default address (LAN for non-V models, LAN 1 for V models) is 192.168.254.254.

Press Enter.
On the login page, enter admin as the username, enter the password (if one has been set), and click Sign In.

e By default, the password is the product serial number.

e If a Full Factory Reset has been performed, then the password is cleared and the Password field can be left blank.

Extron DMP 64 Plus C V AT

Digital audio matrix processor with AEC, VoIP, and Dante

Figure 16. Login Page

The Communications Settings panel displays TCP/IP communication settings. Click Edit to open the Communication
Settings dialog box and edit the TCP/IP settings.

The following can be edited: DHCP status, IP address, subnet mask, and default gateway. This dialog box also displays the
device MAC address. To revert the computer IP address to a range which can communicate to the new IP address schema.

NOTE: If DHCP is enabled, IP address, subnet mask, and default gateway cannot be edited.
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DMP 64 Plus CV AT

Digital audio matrix proces with AEC, VoIP, and Dante l-ilxtronn
Firmware: v1.08.0002

Logged in as: admin m

Figure 17. Communications Settings Panel
To push the DSP template file to the DMP Plus:
1. Open the Extron DSP Template file (downloaded previously in .zip file) with DSP Configurator software.

2. Connectto a DMP 64 Plus C V AT in live mode by clicking the Live button in the menu bar of DSP Configurator (see
figure 18, @). Alternatively, select Tools > Connect to Device or press <F6> on the keyboard. The Connect to Device
dialog box opens.

T -TEE
Emulate

Figure 18. Live Button
3. Click the TCP/IP tab in the dialog box.

4. Enter the IP address of the device in the Hostname or IP Address field. If necessary, enter the device password in the
Password field.

10



Extron Certified DSP Bundle for Microsoft® Teams® Rooms - Medium Room ¢ Setup
Guide

5.

When a connection type with a device is established, the Synchronize with Device dialog box opens. Select Push the

data....

B synchronize with Device — O X

You have elected to change from Emulate mode to live mode. The data in
this configuration must be synchronized with the data in the device. Please
select an option below to continue:

QO Pull data from the device and update this configuration.

Push the data from this configuration to device, overwriting any data
@® currently in it. The device will disconnect after the push if the
configuration and all the presets are not sent.

Push Configuration
[ Push AT Input Channel Names
Push Presets

® Al
O Selected

NOTE: Pushing presets may cause the device to
cycle through each preset that is pushed. This
should not be performed during live operation.

Figure 19. Synchronize with Device Dialog Screen

Click oK. The DSP Configurator software pushes the template settings to the DMP, where they are saved.
Once the push is completed, the current state of the connected DMP 64 Plus C V AT is displayed in the DSP Configurator

status panel and the device is ready for further configuration.

USB Naming

The USB Audio tab allows for customizing USB audio interface names and
terminal types (see figure 20).

NOTE: Extron recommends configuring these settings before

connecting USB audio devices to a PC.

To configure USB audio settings in DSP Configurator:

1.

From the Tools menu, select Device Settings. The Device Settings
dialog box opens.

Click the USB Audio tab.

In the USB Name field, enter the desired name for the USB audio
interface.

In the USB Terminal Type panel, choose Echo Cancelling
Speakerphone.

Click Apply to activate the new settings.
Connect the USB Audio port to the PC.

. Device Settings

? X

Unit Info = IP Settings Passwords = Serial Settings
Date/Time USB Audio Dante Device

Enter a USB Name for the USB Audio interface.
To restore the default name, clear the field and

click Apply.

USB Name : Extron DMP Plus

USB Name can be up to 32 characters drawn from the
alphabet (A-Z), digits (0-9), and special characters
including underscore(_), backslash(\), and spaces.

USB1Te
Appear

rminal Type
as:

@ Echo Cancelling Speakerphone
O Speakerphone

Figure 20.

0K Cancel

USB Audio Tab

11
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IPCP Pro 250 xi Setup

The Control Processor in this system facilitates the communication between the Extron DMP Plus and Sennheiser TCC M.

Get Ready

1. Download and install the latest version of the following software:

¢ Toolbelt — for discovering the control processor and other control products on the network, for managing core settings,
and for upgrading firmware when needed.

¢ Global Configurator Plus and Professional (GCP) — for configuring the control system

2. Obtain network information for the unit from the network administrator. You also need the following details for each Extron Pro
series Ethernet-enabled device:

¢  DHCP setting (on or off) e Subnet mask e Username
e LAN IP address e Gateway IP address e Passwords
e AV LAN IP address

NOTE: If DHCP is on, you do not need the IP addresses and subnet mask.

Write down the MAC address of each network interface on each IP Link Pro device to be used.

Obtain model names and setup information for devices the IPCP controls.

Mount and Cable All Devices

1. Cable devices to the control processor.

2. Connect power cords and power on all the devices.

Network Communication Setup Network Communication Setup

Network setup is essential prior to configuration. Use the flowchart at

right as a guide to setting up the control processor for network use. Connect the PC and the LAN port or AV LAN
port of the control processor to
NOTE: If using 802.1X security, see the Extron 802.1X the same network.
Technology Reference Guide and the Toolbelt Help file for Apply power to all devices.
additional details on system setup. 1

Open the Toolbelt software from within
Global Configurator (GC Professional or
GC Plus mode) or as the stand-alone
application.

Start Device Discovery.

Toolbelt displays a list of all Extron control
devices connected to the network.

y

Using the MAC address, locate the desired
control processor in the list and select it.

v

For each network interface
(LAN, or LAN and AV LAN), use the Set IP
feature in Toolbelt or use the
Toolbelt Manage > Network Settings tab
feature to enter the IP address and
subnet address, then configure other
network settings as needed.

12
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Set Up the Control Processor for Network Communication.

1.
2.

3.

4,

Connect the PC to be used for setup and the LAN (or AV LAN) port of the control processor to the same Ethernet network.
Start Toolbelt and use it to discover the IPCP Pro 250 xi:

TE Toolbelt

File Tools Help

i (4 | T B 2| {7,
Discovery| Add Clear Import Export | _ i| Filter
IP Address Actions Model Name
A 192168250250 £ &% A IPCP Pro 250 xi

Figure 21. Discover IPCP Pro 250 xi with Toolbelt

Log on to the unit:

TE Enter your credentials x

@ Please provide credentials for 192.168.254.250

EXTRON

192.168.254.250
Username
ladmin ]
Password
[sessee ]
I Enter ] [ Cancel

Figure 22. Log on to IPCP Pro 250 xi

NOTES:

¢ The factory configured passwords for all accounts on a device are set to the device serial number. Passwords are
case sensitive.

¢ |f the device is reset to default settings, the password is the default password configuration. The default password is
extron for both Admin and User usernames.

If required, change the password:

.

The following shows the login credentials on the device.

e ———

Termiriaes || <BUS |

—
Current Password New Password
| ] \ ]
MNew Password Confirm Password
[ ] \ ]
Confirm Password Password cannot be blank
E—
Admin password must have
minimum length of 1
character

Figure 23. Change Password
13
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5. Setthe DHCP status, IP address, subnet, gateway IP address, and related settings.

R —
The following shows the

k settings related to the device.

Communicate to this device via a friendly-name.

|IPCP-Pro-250-xi |

ooy [ come ]

Network Interfaces

Settings related to the Network Interface Card.
[] Use DHCP (Obtain IP Address Automatically)

IP Address* |192.168.254.249 ]
Subnet Masic* [255.255.255.0 ]
Gateway* [0.0.00 |
DNS Server 1 [ |
DNS Server 2 [ |
DNS Server 3 [ ]
Search Domains [ ]
[ aoy [ coxe |

Figure 24. Configure Network Settings

NOTES:

¢ When setting up DHCP during network configuration or if using a host name instead of an IP address, the user must
enter a qualified host name (Username.HostName.Domain). For example: somename. extron. com.

¢ Adedicated AV LAN safeguards AV systems from outside intrusion or interference by separating device control and
other network traffic from a corporate or campus network. To ensure that the control processor LAN and AV LAN
connections (ports) are connected to separate networks, the LAN and AV LAN IP address schemes must be on
different subnetworks.

See the Network Communication Setup flow chart on page 12.
6. If required, apply a LinkLicense.

i 5| s | sy | [
The following shows the LinkLicenses that are applied to this device. Learn More.

b | | [- ] [omr]

You can redeem your LinkLicense by clicking here www.extron.com/LLRedeem

No LinkLicenses found.

Figure 25. Apply LinkLicense

14
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Configure or Program the Control Processor

Introduction to Global Configurator

NOTE: See the Global Configurator Plus and Professional Help File as needed for step-by-step instructions and detailed
information. The help file for GCP includes an introduction to the software and how to start a project and configuration.

Use Global Configurator to configure the control processor. The configuration tells the control processor:

e How its ports function e How its ports function

e How to control other products e When to do things
e Whom to notify, how, and under what circumstances

Configuration with GC Plus
1. Open provided GC Plus configuration file
Software opens to Configuration view ([=)). This option is also selectable from the View menu.

6¢ Global Configurator

File Project View Build Tools Help

EEEREOENRREEN

IPCP Pro 250 xi : MTR > System Settings

L - 2 ke Gt ot
i il + 5 e IPCP Pro 250 xi: MTR i) o |
IP Address/Hostname 192.168.254.250
Username famn = ] passwora T 2 —
System Information
Sytemi0 ()
— Must be 4 digits and within the range 0001.
Configuration Palette =
3 Live Hardware Information (o
o
o - -
g LAN Device Information
Settings fors fors Subnet Mask Model Name

Gateway Firmware Version

Figure 26. Configuration View — System Settings page for Control Processor

2. Setthe IP address (see figure 26, @) and Admin password (@) of IPCP Pro Control Processor.

NOTES:
¢ The factory configured passwords for all accounts on a device are set to the device serial number. Passwords are

case sensitive.
¢ [f the device is reset to default settings, the password is the default password configuration. The default password is

extron.

3. Open the Communications Ports page (€)).

15
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6. Choose TeamConnect Ceiling Medium under the Ethernet Ports list (see figure 28, @).

7.

 Global Configurator

File Project View Build Tools Help

IPCP Pro 250 xi

Configuration Palette =|

ff’eﬁ%

il
Settings
Schedules Monitors Macros

‘Communication Ports
] Seril Ports mmmmmeeeeeeeeo

@ senal Port 1
@D sesial Port 2
[l ir/sesial ports

| 1R/serial Port 1

£l Ethernet Ports

=g

Sennheiser - TeamConnect Ceil..
Ethernet Port 2

[* Ethernet Settings

1P Address/Hostname
182.168.254.249

SSH Port
22023
I Driver Settings

Extron - DMP 64 Plus C V AT v5.0

Auto-mixer Gate Set { In;
Auto-mixer Gate Status { Input , Value )
Connection Status { Value )

Digital Input Status { Input, Value )
Input Signal Level Monitor { Input , Monitoring
Input Source { Input , Value )

Macro ( Macro , Value )

Mix-point Gain ( Inpct, Output, Value )

Part Number { Value )

Phantom Power { Inpct , Value )

Preset Recall { Value )

Preset Save ( Value )

USE Call Status ( Value )

User Defined Command

User Defined String ( Value )

Dante AT Input Premixer Gain ( Dante Device
Dante DC Protection Fault ( Dante Device, Val
Dante Digital
Dante Group Mic/Line Input Gain ( Dante Dev
Dante Group Mix-point Gain ( Dante Device ,
Dante Group Mute ( Dante Device, Group , Va
Dante Group Output Attenuation ( Dante Dev
Dante Group Post-mixer Trim ( Dante Device,

( Dante Device, Output, Va

Name
Description

Polling Interval (sec)  Initialized Only.

Supported Feedback Live
Line List (Enum)

Value List (Enum)

S —

Default Line 1 v
: ‘

e —rY <]

| —

| —

o — [ <]

Namels ] :A‘

S —

Gial

Figure 27. Configuration View — Communications Ports page for DMP Plus

Choose DMP P1us under the Ethernet Ports list (see figure 27, @).
Set IP address (@) and Admin password of the DMP Plus device (€)).

5¢ Global Configurator

File Project View Build Tools Herp

Dlea). {=els

IPCP Pro 250 xi : MTR.
IPCP Pro 250 xi

Configuration Palette =

o“‘ﬁ%

smen CaSEY
Settings

Moniters Macros

@D Sesial Port 1
@D Sesial Port 2

IR/Serial POFts. m—
IR/Serial Port 1
Ethernet Ports.

Extron - DMP 64 Plus C V AT v..

Ethernet Port 1

~ Communi Settings

Ethernet Serial over Ethernet

I Ethemet Settings

1P Address/Hostname
192.168.254.248
HTTP Port

443

I Driver Settings

Password

CrTTTT—

SSL Verify Mode

Beam Direction ( Type , Value }
Connection Status ( Value )
Device Name ( Value )
Firmware Version { Value )
Identify Device

Installation Type { Value )
Mute ( Value )

Sensitivity Threshold ( Value )

Analog Output Gain ( Value )
Analog Output Source ( Value )

Exclusion Zone Azimuth ( Zone , Min , Max )

Exclusion Zone Elevation ( Zone , Min , Max )
Exclusion Zone Elevation Status ( Zone , Type

Exclusion Zone Mode ( Zone , Value )

Far End Qutput Delay ( Value )
Far End Output Gain ( Value )
Far End Output Sound Profile  Value )

Input Level Gain ( Value )
LED Show Far End Activity ( Value )

Exclusion Zone Azimuth Status ( Zone , Type ,

| 1PCP Pro 250 i : MTR > Communication Settings > Ethernet Port 2 - Sennheiser - TeamConnect Ceiling Medium v1.2

Sennheiser - TeamConnect Ceiling Medium v12  p&

Name
Description

Polling Interval (sec) 3k]
Supported Feedback  Emulated Live

Parameters

Default Value Activated

Acdtivated
[ um]

[m i -‘z\‘

Figure 28. Configuration View — Communications Ports page for TCC M

Set IP address (@) and password (€)) of the TCC M device.

16



Extron Certified DSP Bundle for Microsoft® Teams® Rooms - Medium Room ¢ Setup
Guide

8. Open Build Manager view (see figure 29, @, [&)). This option is also selectable from the View menu.

&< - Global Configurator

Help

1PCP Pro 250 xi: MTR
E i - IPCP Pro 250 xi

File Project View Buid Tools
EEEIREOFR
Build Options 1

I verification

Hardware
Configuration

= Build & Upicad

Build Progress

Upload Progress

Figure 29. Build Options panel
9. Under the Build & Upload section, click the Build button.
10. Wait for Verification. The Build and Upload bars show the progress.

N

[ Verification

[v] Hardware
Complete

[v] Configuration
Complete

I Build & Upioad
Build Progress
Complete
Upload Progress

Complete

Figure 30. Build and Upload Completed
11. Once the process is complete, the Build and Upload bars both show the message Complete (see figure 30).

Test and Troubleshoot

Test the system (see the IPCP Pro Q xi and xi Series User Guide for an outline of the system testing procedure). Make adjustments
to wiring or configuration as needed.
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Microsoft Teams Rooms Setup

The Extron DMP 64 Plus connects to the Microsoft Teams Rooms system from the USB Audio port. Once the previous steps
outlined in this document have been completed, connect the Microsoft Teams Rooms system to the DMP 64 Plus USB Audio
connection via the provided USB mini-B cable.

The following steps detail the required settings on the Microsoft Teams Rooms device:

Select Settings (see figure 31, @) in the Microsoft Teams Rooms interface.

X H

Meet now Join with

an ID

i C 0O

Accessibility Restart Settings
device

Figure 31. Microsoft Teams Rooms Setup

Microsoft Teams Rooms Interface Screen

Select the Extron DMP Plus (or configured USB Name in above steps) for each of the two parameters: Microphone (see
figure 32, @) and Speaker (@).

Settings

® About i Cameras
Default Video Camera
S Account
Echo Cancelling Speakerphone (DMP Plus US... None
= Advanced
Speaker for Conferencing Content Camera

Meetings
Echo Cancelling Speakerphone (DMP Plus US...

Device

75

Coordinated meetings

Peripherals
Echo Cancelling Speakerphone (DMP Plus US... v

Select a background > —. 75

SR Windows Settings O

Reset Device Exit without saving Save and exit

Figure 32. Microsoft Teams Room Interface Screen

Microsoft Teams Rooms Settings Menu

NOTE: When using the Extron DMP 64 Plus, Microsoft Teams Rooms Rooms disables its internal acoustic echo cancellation
(AEC) audio processing so that all audio processing is completed through the external DSP — the Extron DMP 64 Plus.
This provides the best audio performance.
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Troubleshooting

19

DMP Plus Acoustic Echo Cancellation (AEC)

AEC Setup Overview

Proper gain structure involves the relationship between the signal at the selected reference and the signal at the mic input, within
the context of proper levels for the reference and mic inputs independently. The mic input gain setting is naturally optimized for the
voice level of the talker in that room. Therefore, the amount of signal from the far end that is picked up by the mic is dependent on
how much that far end signal is being amplified in the near end room and the distance from the mic to the speakers.

The reference signal is the signal received from the far end, which arrives at the USB-assigned Aux Inputs of the DMP Plus. This is
sent to the sound reinforcement system within the near end room, as well as a designated output channel to set the reference level

for the DMP Plus AEC processor.

AEC Dialog

The AEC dialog in DSP Configurator contains meters and indicator LEDs that are essential for
setting up gain structure and monitoring activity.

@ AEC Activity Indicators (see figure 33)

e Far - lights when activity is detected from the remote site.

e Near - lights when activity is detected from the local site.

e Update - lights when the AEC is updating (converging or reconverging)
© Meters

e ERL —the ratio in dB between the signal at the reference and the signal at the AEC
channel input. When ERL is a positive number, the signal level at the AEC channel
input is lower than the signal at the selected reference.

e ERLE —the amount in dB of potential echo signal that the AEC algorithm, not including
NLP processing, is cancelling.

e TER —the sum of ERL + ERLE, in dB.

NOTE: The ideal level range for this meter is 0 to +15 dB. This ensures the right
amount of reference signal is being sent through the AEC processor.

@© Reference Selection List — The provided configuration includes a selected AEC
reference. If necessary, a different AEC reference can be selected from the drop-down list.

@ Noise Cancellation Controls — Noise cancellation can be switched on or off from the
AEC dialog. The noise canceller detects steady state noise, such as HVAC, and effectively
removes it without causing audible artifacts.

@ Advanced AEC Controls — Click the expand and collapse icon to expose the advanced
AEC controls.

Advanced control functionality is as follows:

¢ Non-linear Processing (NLP) Controls:

TCC M- AEC ? b4
Activity
o Far: Near: mm  Update: mm
ERL ERLE TER
Leved indB Leved indB Leved indB
oI | K
i i -30
5 510 Ifm 20
2 - -0 -20 -10
% 10 “10 e
N N 8 -10
-20 -0 -20
E EE B
Reference: |AEC Ref (VitiRet #P) v|
Noise Cancellation

[A] Cancel Noiseby: 150 |2 dB

Bypass OK Cancel
-~
Enable NLP
NLP Presets:
Soft Nomal Aggressive

Max NLP Reduction:  45.0 dB
Atack Time: 5.0

Release Time: 50.0

ms

O

ms

Double Talk Echo Reduction: 12.0
Comfort Noise: 0.0

dB
dB

Figure 33. AEC Controls

e Enable NLP — This box is selected by default. Non-linear processing is necessary for the complete removal of echo.

e NLP Presets — Click a button to load a set of values to the three NLP parameters. If not using one of these presets,

enter values into the fields for the following three controls:

e  Max NLP Reduction — The maximum possible reduction in echo artifacts that can be applied

e Attack Time — The speed in which NLP is applied
e Release Time — The speed in which NLP is released

e Additional Controls:

e Double Talk Echo Reduction — Sets the amount of echo reduction applied during double-talk (when two people

speak at the same time).

e Comfort Noise — Sets a comfort noise level in dB to eliminate states of complete silence, which may be perceived as

a failed connection.



Extron Certified DSP Bundle for Microsoft® Teams® Rooms - Medium Room ¢ Setup
Guide

Technical Support

For Extron technical support, visit: www.extron.com/company/contactus.aspx.

For Sennheiser technical support, visit: sennheiser.com/service-support.

For information on safety guidelines, regulatory compliances, EMI/EMF compatibility, accessibility, and related topics, see the Extron
Safety and Regulatory Compliance Guide on the Extron website.
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